
User’s Guide
4113114-01



Copyright and Trademarks 2

Copyright and Trademarks

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any 
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko 
Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is 
not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for 
damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or 
abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) 
failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or 
any consumable products other than those designated as Original Epson Products or Epson Approved Products 
by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that 
occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko 
Epson Corporation.

EPSON® is a registered trademark and Exceed Your Vision is a trademark of Seiko Epson Corporation.

Microsoft® and Windows® are registered trademarks, and Windows Vista™ is a trademark of Microsoft 
Corporation.

Part of the photo data stored on the Software CD-ROM is licensed from Design Exchange Co., Ltd. Copyright © 
2000 Design Exchange Co., Ltd. All rights reserved.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of 
their respective owners. Epson disclaims any and all rights in those marks.

Copyright © 2008 Seiko Epson Corporation. All rights reserved.
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Important Notice and Safety Instructions

Important Note

You may use the software to operate the EPSON PP-100. You may use the EPSON 
PP-100 to copy materials onto disc, including but not limited to CDs and DVDs. You agree 
to respect the rights of copyright owners. EPSON shall have no liability for, and you shall 
hold EPSON harmless from, any copyright infringement by you or your employees, 
representatives, or agents.

Important Safety Instructions

New :Depends on modelRead all the instructions in this section before using the product. Also, be sure to follow all 
warnings and instructions marked on the product.

Setting up the product

2007/05/29 10:29:21070511 unlocked and changedObserve the following when setting up the product:

❏ Do not block or cover the vents and openings in the product.

❏ Use only the type of power source indicated on the product’s label.

❏ Use only the power cord that comes with the product. Use of another cord may result in 
fire or electric shock.

❏ The product’s power cord is for use with this product only. Use with other equipment 
may result in fire or electric shock.

❏ Be sure the AC power cord meets the relevant local safety standard.

❏ Avoid using outlets on the same circuit as photocopiers or air control systems that 
regularly switch on and off.

❏ Avoid electrical outlets controlled by wall switches or automatic timers.

❏ Keep the entire computer system away from potential sources of electromagnetic 
interference, such as loudspeakers or the base units of cordless telephones.

❏ Do not use a damaged or frayed power cord.
Important Notice and Safety Instructions 7



❏ If you use an extension cord with the product, make sure that the total ampere rating of 
the devices plugged into the extension cord does not exceed the cord’s ampere rating. 
Also, make sure that the total ampere rating of all devices plugged into the wall outlet 
does not exceed the wall outlet’s ampere rating.

❏ Do not attempt to service the product yourself.

❏ Unplug the product and refer servicing to qualified service personnel under the 
following conditions:
The power cord or plug is damaged; liquid has entered the product; the product has 
been dropped or the casing is damaged; the product does not operate normally or 
exhibits a distinct change in performance.

❏ If you plan to use the product in Germany, the building installation must be protected by 
a 10 or 16 amp circuit breaker to provide adequate short-circuit protection and 
over-current protection for the product.

❏ When connecting the product to a computer or other device with a cable, ensure the 
correct orientation of the connectors. Each connector has only one correct orientation. 
Inserting a connector in the wrong orientation may damage both devices connected by 
the cable.

❏ If damage occurs to the plug, replace the cord set or consult a qualified electrician. If 
there are fuses in the plug, make sure you replace them with fuses of the correct size 
and rating.

❏ Commercially available replacement drives do not function on this product.

Choosing a place for the product

Observe the following when choosing a place for the product:

❏ Place the product on a flat, stable surface that extends beyond the base of the product 
in all directions. If you place the product by the wall, leave more than 10 cm (3.94") 
between the back of the product and the wall. The product will not operate properly if it 
is tilted at an angle.

❏ When storing or transporting the product, do not tilt it, stand it on its side, or turn it 
upside down. Otherwise, ink may leak from the cartridges.

❏ Leave enough space in front of the product for the disc cover to be fully opened.

❏ Avoid places subject to rapid changes in temperature and humidity. Also, keep the 
product away from direct sunlight, strong light, or heat sources.

❏ Avoid places subject to dust, shocks, or vibrations.
Important Notice and Safety Instructions 8



❏ Leave enough room around the product to allow for sufficient ventilation.

❏ Place the product near a wall outlet where the plug can be easily unplugged.

Using the product

Observe the following when using the product:

❏ Do not insert objects in the product.

❏ Take care not to spill liquid on the product.

❏ Do not use aerosol products that contain flammable gases inside or around this 
product. Doing so may cause fire.

❏ Always turn the product off using the P power button. When this button is pressed, the 
 power light flashes. Do not unplug the product or turn off the power to the outlet 

until the  power light stops flashing.

❏ Leave the ink cartridges installed. Removing the cartridges can dry out the print head 
and may prevent the product from printing.

❏ Be careful not to trap your fingers when closing the disc cover.

❏ The product uses galvanized sheet metal and this may cause rusting at the edges; 
however, this does not cause any harm to the function of the product.

❏ Do not place any drink or liquid on the product as penetration by liquid inside the 
product will cause a malfunction.

Handling ink cartridges

Observe the following when handling the ink cartridges:

❏ Keep ink cartridges out of the reach of children. Do not allow children to drink from or 
handle the cartridges.

❏ Do not shake ink cartridges after opening their packages; this can cause leakage.

❏ Be careful when you handle used ink cartridges, as there may be some ink remaining 
around the ink supply port. If ink gets on your skin, wash the area thoroughly with soap 
and water. If ink gets into your eyes, flush them immediately with water. If discomfort or 
vision problems remain after a thorough flushing, see a doctor immediately.

❏ Do not remove or tear the label on the cartridge; this can cause leakage.
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❏ Install the ink cartridge immediately after you remove it from its package. If you leave a 
cartridge unpacked for a long time before using it, normal printing may not be possible.

❏ Use the ink cartridge before the expiration date printed on its package.

❏ Do not dismantle ink cartridges or try to refill them. This could damage the print head.

❏ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at 
room temperature for at least three hours before using it.

❏ Store ink cartridges in a cool, dark place.

❏ Do not touch the green IC chip on the side of the cartridge. Doing so may prevent 
normal operation and printing.

❏ The IC chip on this ink cartridge retains a variety of cartridge-related information such 
as the ink cartridge status, so that the cartridge may be removed and reinserted freely. 
However, each time the cartridge is inserted, some ink is consumed because the 
product automatically performs a reliability check.

❏ If you remove an ink cartridge for later use, protect the ink supply area from dirt and 
dust, and store it in the same environment as the product. A valve in the ink supply port 
makes covers or plugs unnecessary, but the ink may stain items that come into contact 
with this area of the cartridge. Do not touch the ink supply port or the surrounding area.

❏ Do not store ink cartridges with the ink supply area facing down. This may result in ink 
leakage. Also, dirt attached to the ink supply area may result in the product not 
functioning properly.

Notice for CD/DVD discs

Before using the product, operation check should be conducted to make sure the 
functionality. Also, back up of the data on the CD/DVD should be taken if needed. Data 
may be damaged or lost in the following cases:

-Influence of static or electrical noise
-Incorrect usage
-Malfunction or repair
-Damage due to natural disaster 

Epson does not hold any responsibility for lost or damaged data, due to the cause not 
limited to the above listed, even the product is under warranty period.
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Concerning incidental loss arising out of this product

Should the expected results from this product, including bundled software, not be obtained, 
we cannot compensate for incidental loss arising from that fact, such as expenses required 
for use of this product and lost earnings that would have been gained through the use of 
this product.

About usage limitation

❏ When this product is used for applications requiring high reliability/safety such as 
transportation devices related to aviation, rail, marine, automotive etc.; disaster 
prevention devices; various safety devices etc; or functional/precision devices etc, you 
should use this product only after giving consideration to including fail-safes and 
redundancies into your design to maintain safety and total system reliability. Because 
this product was not intended for use in applications requiring extremely high 
reliability/safety such as aerospace equipment, main communication equipment, 
nuclear power control equipment, or medical equipment related to direct medical care 
etc, please make your own judgment on this product’s suitability after a full evaluation.

❏ When copying a CD or DVD, you must meet the conditions that the work recorded on 
the discs do not have a copyright, that you have a copyright for the work, that you have 
received permission from the author, or that copying of the work on-to the discs is 
legally approved. Copying of a CD or DVD without meeting these conditions is illegal 
and should not be done.

❏ This product is for business use and not for household use.

Warnings, Cautions, and Notes

Warnings, Cautions, and Notes in this User's Guide as indicated below have the following 
meanings.

w
Warnings
must be followed carefully to avoid bodily injury.

c
Cautions
must be observed to avoid damage to your equipment.

Notes
contain important information and useful tips on the operation of the product.
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WARNING

The connection of a non-shielded interface cable to this product will invalidate the EMC 
standards of this device. You are cautioned that changes or modifications not expressly 
approved by Seiko Epson Corporation could void your authority to operate the equipment.

FCC Compliance Statement For American Users
This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation.This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instruction manual, may cause harmful interference to 
radio communications. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following 
measures:
-Reorient or relocate the receiving antenna.
-Increase the separation between the equipment and receiver.
-Connect the equipment into an outlet on a circuit different from that to which the receiver 
is connected.
-Consult the dealer or an experienced radio/TV technician for help.

For Canadian Users
This Class B digital apparatus complies with Canadian ICES-003.
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Chapter 1 

Using Your Software

Adding the product

Use the EPSON Total Disc Setup to add the product (CD/DVD publisher) to the computer.

1. Select Start - All Programs (or Programs) - EPSON Total Disc Maker - EPSON 
Total Disc Setup.

The EPSON Total Disc Setup will start.

2. Click Add.

3. Select the product to be added from CD/DVD Publisher List, then click Next.

4. Enter name and click OK.

Adding the product is complete.

Overview of EPSON Total Disc Maker

2007/02007/02/22 17:07:16Unlocked and changed.2/22 17:07:16Unlocked and changed.The EPSON Total Disc Maker software included with the product allows you to write or 
copy CDs/DVDs, create CD/DVD labels, and publish CDs/DVDs.

EPSON Total Disc Maker

EPSON Total Disc Maker lets you write CDs/DVDs and print CD/DVD labels. The process 
used to write CDs/DVDs and print CD/DVD labels is called "Publish" in the EPSON Total 
Disc Maker program. Using EPSON Total Disc Maker, you can also duplicate CDs/DVDs.

EPSON Total Disc Monitor

EPSON Total Disc Monitor is a utility that monitors the product and gives you information 
about its current status. 
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EPSON Total Disc Setup

EPSON Total Disc Setup is a utility to register the product to the computer.

Using EPSON Total Disc Maker

New :For Ink Jet PrinterNew :For Ink Jet PrinterUse EPSON Total Disc Maker to do the following:

❏ Writing data to DVDs, data to CDs, music to CDs, music and data to CDs, or video to 
CDs, or copying CD/DVDs.

❏ Creating and editing CD/DVD labels.

Starting EPSON Total Disc Maker

2007/05/29 10:29:21070511 unlocked and changed2007/05/29 10:29:21070511 unlocked and changedClick Start, point to All Programs (Windows XP) or Programs (Windows 2000), point to 
EPSON Total Disc Maker, and then click EPSON Total Disc Maker.

For more information, select Help from the Help menu in this software.

Overview of Printer Driver

2007/03/23 09:39:18070313 Unlocked and changed2007/03/23 09:39:18070313 Unlocked and changedThe printer driver lets you choose from a wide variety of settings to get the best printing 
results.

Accessing the printer driver

You can access the printer driver from most Windows applications and the Windows Start 
menu.

To make settings that apply only to the application you are using, access the printer driver 
from that application.

To make settings that apply to all your Windows applications, access the printer driver from 
the Start menu.

Refer to the following sections to access the printer driver.
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From Windows applications

1. Click Print or Print Setup in the File menu.

2. In the window that appears, click Printer, Setup, Options, Preferences, or 
Properties. (Depending on your application, you may need to click one or a 
combination of these buttons.) 

From the Start menu

2007/05/29 10:29:21070511 unlocked and changed2007/03/23 09:39:18070313 Unlocked and changed1. Windows XP:
Click Start, Control Panel, then click Printers and Faxes. (If the Control Panel is in 
Category View, click Printers and Other Hardware, then click Printers and Faxes.) 

Windows 2000:
Click Start, point to Settings, then click Printers or Printers and Faxes.

2. Select the printer, then click Printing Preferences in the File menu.

Getting information through online help

2007/05/29 10:29:21070511 unlocked and changed2007/05/29 10:29:21070511 unlocked and changedYou can access online help for items in the printer driver from your application or the 
Windows Start menu.
& See “Accessing the printer driver” on page 14.

In the printer driver window, try one of the following procedures.

❏ Right-click the item, then click Help.

❏ Click the  button at the top right of the window, then click the item (for Windows XP 
and 2000 only).

Uninstalling EPSON Total Disc Maker

You can uninstall applications you do not need. Follow the steps below.

Note:
❏ To uninstall applications, you must log on as a user with administrative privileges (belonging to 

the Administrators group).

❏ When installing the application, various Microsoft components may be installed. Some of them 
may not be uninstalled when uninstalling the application.

1. Windows XP:
Click Start, and then select Control Panel.
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Windows 2000:
Click Start, point to Settings, and then select Control Panel.

2. Double-click the Add or Remove Programs icon.

3. Choose the software you want to uninstall from the list of programs.

4. Click Change/Remove.

5. When the confirmation message appears, click Yes.

6. Follow the on-screen instructions.
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Chapter 2 

Publishing Discs

Introduction

This section guides you through the procedures for creating and printing CDs/DVDs.

Note:
For information on CDs/DVDs, see the following section.
& See “Discs” on page 90.

Turning power on/off

This section describes how to turn on/off power.

Turning power on

1. Connect the power cable.

2. Press P power button until the power light flashes.

Power light flashes in green, then stays on.

Turning power off

Press the P power button for more than 1 second. The power light will flash in green 
then turn off; then power is turned off.

c
Caution:
❏ Fan will operate after turning power off, but it will automatically stop after 15 minutes.

❏ If the product is operating, wait for 10 seconds after operation is stopped, then turn off 
power.

❏ The product may not be recognized by the computer when the power is turned back on 
while fan is operating. In this case, disconnect the USB cable and connect it again.

Note’
❏ If turning off the product while power on the PC is on, follow the procedure below. If the product 

is turned off without following the procedure, data in the PC maybe damages.
1. If Total Disc Maker, Total Disc Monitor, or Total Disc Setup is running, close the application.
2. Double click "Safely Remove Hardware" on the task tray.
3. Select DVD drive on the product and select Stop.
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❏ The product may not be recognized by the computer when turning the power back on while fan 
is operating. In this case, disconnect the USB cable and connect it again.

Overview of publishing mode

New :Only for model with this featureTo write data to CDs/DVDs and to print labels that you created/edited are called “Publish” 
in EPSON Total Disc Maker. The product has three kinds of publishing modes.

Standard Mode

This mode uses Stacker 1 as the input source, and Stacker 2 or 4 as the output source.

When Stacker 2 is selected as the output source, up to 50 CDs/DVDs can be created at 
once. Also, if you refill discs to the input stacker and take out published discs from the 
output stacker at the same time, up to 1000 CDs/DVDs can be published in a single job. 

If Stacker 4 is selected as output source, discs can be removed without stopping the 
product while running a job.

Note:
This mode does not use Stacker 3.

& See “Standard Mode” on page 22.

External Output Mode

This mode uses Stacker 1 and 2 as the input sources, and Stacker 4 as the output source.

Different types of discs (CD and DVD) can be loaded into each of the 2 stackers and can 
create different types of discs. This is ideal for creating small batches of discs at once.

If Auto is selected for Input Stacker setting, up to 100 CDs/DVDs can be created at once. 
If a setting other than Auto is selected, up to 50 CDs/DVDs can be created at once.

Since discs are ejected to Stacker 4, discs can be removed without stopping the product 
while running a job.

Note:
This mode does not use Stacker 3.

& See “External Output Mode” on page 30.

Batch Mode

This mode uses Stacker 1 and 2 as the input source, and Stacker 2 and 3 as the output 
sources. 
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You can create up to 100 CDs/DVDs at once without refilling and taking out discs while 
publishing. To use this mode, you need to place Stacker 3 into the product.

Note:
This mode does not use Stacker 4.

& See “Batch Mode” on page 40.

Drive settings

Drive to be used

Select Drive to Use from the following.

Use Both

Use both Drive 1 and 2 to write data. Job will be efficiently processed by using 2 drives. If 
trouble occurrs on either drive and it cannot write data, other drive will be used 
automatically.

Use Drive 1 Only

Use only Drive 1.

Use Drive 2 Only

Use only Drive 2.

Number of write retries

Select 0 to 9 for the Number of write retries.

the Number of write retries is a setting to retry writing if a write error occurs.

Setting the Number of write retries will enable the job to continue without pausing if a write 
error occurrs.

Printer settings

Printer name

Select Printer Name
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Show error mark on discs that experience errors

If you check this check box, an error mark will be printed on any disc with a write error. This 
is useful to identify the disc which encountered the write error.

The disc with the write error will be ejected to different stackers depending on the print 
mode.

❏ Standard Mode: Ejected to Stacker 4

❏ External Output Mode: Ejected to Stacker 4

❏ Batch Mode: Ejected to Stacker 2 or 3

Note:
The error mark will not be printed in the following cases.

❏ The job was cancelled

❏ An incorrect disc type was found in the stacker

❏ Fatal error

❏ Not enough ink was left to print the error mark

Notice for CD/DVD writing and printing

2007/05/29 10:29:21070511 unlocked and changed

❏ Store the stacker out of direct sunlight. A warped or damaged stacker may stop the 
product from operating normally.

❏ Use only CDs/DVDs labeled as suitable for printing, for example “Printable on the label 
surface” or “Printable with ink jet printers.”

❏ For more details on handling CDs/DVDs and for guidelines for writing data to 
CDs/DVDs, refer to your CD/DVD documentation.

❏ Do not print on the CD/DVD before writing your data to it. If you do, fingerprints, dirt, or 
scratches on the surface may cause errors while writing data.

❏ When using the product for the first time after storing it for a long time or after an error, 
dead pixels or ink stains may appears and print quality may be reduced. If publishing 
large a number of discs, check print quality of the first disc published. If a dead pixel is 
found, run Head Cleaning.

❏ When writing and printing discs separately, its is recommended to print after writing. If 
you write discs after printing, ink may cause discs to stick to each other and result in a 
transport error, or dirt, stains, or scratches on the disc may cause a write error. 
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❏ Printing on rib area may result in ink sticking, disc sticking, or color loss.

❏ Try to test print on a spare CD/DVD, and check the printed surface after waiting for one 
full day, especially before printing a large amount of CDs/DVDs.

❏ After printing the first copy, check the print quality to see if any dots are missing.

❏ Before using or touching the printed surface of your CDs/DVDs, make sure they are 
completely dry and keep them out of direct sunlight.

❏ Depending on the CD/DVD type, smearing may occur, depending on the level of color 
saturation.

❏ If the printed surface is sticky even after it has dried, the color saturation level may be 
too high. In that case, lower the level of the color saturation in the Color Settings dialog 
box of the printer driver.

❏ Moisture on the printable surface may cause smearing.

❏ When using Epson specified discs, High Speed can not be selected.

❏ Reprinting on the same CD/DVD may not improve the print quality.

❏ Be sure to clean the inside of the stacker before using.

❏ Please check disc before printing, as the size of the receptor may vary.

❏ Ink may not bond if printed outside the receptor.

❏ Turning the product on or off while a disc is in the printer tray may cause a malfunction. 
Make sure the disc is removed before turning the product on or off.

❏ Data may be lost depending on the disc or storing condition; therefore, store important 
data on multiple discs. Epson does not guarantee the data against loss.

❏ Do not insert a disc between DVD drive 1 and DVD drive 2, as you may not be able to 
remove it.

❏ Do not insert an object like a screwdriver or clip into the CD/DVD slots as this may 
cause a malfunction.

❏ Do not use a disc created with this product with an auto loading mechanism, drive with 
holding mechanism of more than 33 mm in diameter, or automotive equipment. 
Depending on the environment used, printing surface may stick.

❏ A published CD/DVD may not be readable on another type of drive or player due to 
compatibility.
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❏ The quality of the blank disc determines write quality. It is recommended to use only the 
specified disc type.

❏ It is recommended that you run a compare while writing data.

❏ Making a backup is recommended if the data is important. Recorded data may degrade 
over long storing periods. It is recommended to make backups periodically.

❏ Do not shock or vibrate the product while reading or writing, as this may result in 
malfunction of the drive or make the disc unusable.

❏ Do not use a cracked, warped, or deformed discs because it may break in pieces inside 
the product and cause malfunction or injury.

❏ A disc may become unreadable or unwritable if it has a small scratch or dirt; therefore, 
please handle it with care. 

❏ Do not touch both surfaces when holding a disc.

❏ Created discs may not be readable in some players.

❏ The completed job display of EPSON Total Disc Monitor shows the number of 
successes, number of failures, and number of discs printed.

Printing on CDs/DVDs with a commercially available software 
package

When you print on CDs/DVDs with a commercially available software package that 
supports CD/DVD printing, you have to make the following settings.

Standard Mode

Loading CDs/DVDs

Follow the steps below to load CDs/DVDs.

Size 124 x 124 mm (4.88 x 4.88")

Type CD/DVD Label, CD/DVD Premium Label, or EPSON 
Specified CD/DVD Label

Margins on all sides 2 mm (0.08")
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Note:
❏ Do not open disc cover while running a job (busy indicator is flashing), unless the application 

instructs to add or remove discs. This may affect write quality or print quality. Also, for safety 
reason, do not put your hands inside the product while beeping as arm is still moving.

❏ Beep will sound if you open disc cover while running a job, and the job will pause. Closing the 
disc cover automatically resume the job.

❏ Pause a job if you need to open the disc cover.

1. Open the disc cover.

2. Take out Stacker 1.

3. Fan a stack of discs to prevent them from sticking together. Be careful not to scratch the 
recording side of the disc.
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4. Load CDs/DVDs into Stacker 1 with the printable side facing up.

c
Caution:
Do not load the discs above the red line marked on the stacker; otherwise, the discs or 
product may be damaged.

5. Insert Stacker 1.
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6. Close the disc cover.

c
Caution:
❏ Do not yank Stacker 4 when pulling it out to remove published discs.

❏ Do not remove Stacker 4 when the Stacker 4 LED is flashing fast. Discs may be 
damaged.

❏ Unlock the lock lever when using Stacker 4.

❏ If you use Stacker 4 for output, do not install Stacker 3.

Making disc settings and creating labels

After loading discs into the stacker, access EPSON Total Disc Maker to make settings for 
writing discs, and create the labels printed on the discs.

Accessing EPSON Total Disc Maker

Click Start, point to All Programs (Windows XP) or Programs (Windows 2000), point to 
EPSON Total Disc Maker, and then click EPSON Total Disc Maker.

To learn how to use EPSON Total Disc Maker, go to the Help menu.
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Publishing discs

2007/05/29 10:29:21070511 unlocked and changedThe following instructions explain how to publish CDs/DVDs.

Note:
❏ Be sure to let CDs and DVDs to dry completely before using them or touching the printed 

surface. Allow Epson specified discs to dry for at least 1 hour and other types of discs for at 
least 24 hours.

❏ If the print position is misaligned, adjust it using the printer driver. For details, refer to the printer 
driver Help.

❏ If the ink smears, adjust the color saturation. For details, refer to the printer driver Help.

Making the stacker settings

1. Make sure that the product is turned on, and the product and computer are properly 
connected.

2. Start EPSON Total Disc Setup, select Properties from Edit menu.
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3. Select Standard Mode for Publish Mode.
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4. Select the type of discs that you loaded into the stacker.

5. Click OK.

Publishing Discs

1. Make the publish settings on the Publish screen of EPSON Total Disc Maker. For 
details, see Help for EPSON Total Disc Maker.

Note:
To access Help for EPSON Total Disc Maker, select Help from the Help menu.
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2. Click the Publish button.

c
Caution:
❏ Do not open the disc cover while the product is publishing discs, unless the application 

instructs to add or remove discs. This may affect write quality or print quality. Also, do not 
put your hands inside the product while beeping as arm is still moving.

❏ If you need to open the disc cover, pause or cancel your job before opening the disc 
cover.
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External Output Mode

Loading CDs/DVDs

Follow the steps below to load CDs/DVDs.

1. Open the disc cover.

2. Take out Stacker 1.

3. Fan a stack of discs to prevent them from sticking together. Be careful not to scratch the 
recording side of the disc.
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4. Load CDs/DVDs into Stacker 1 with the printable side facing up.

c
Caution:
Do not load the discs above the red line marked on the stacker; otherwise, the discs or 
product may be damaged.

5. Insert Stacker 1.
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6. Take out Stacker 2.

7. Fan a stack of discs to prevent them from sticking together. Be careful not to scratch the 
recording side of the disc.

8. Load CDs/DVDs into Stacker 2 with the printable side facing up.

c
Caution:
Do not load the discs above the red line marked on the stacker; otherwise, the discs or 
product may be damaged.
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9. Insert Stacker 2.

10.Close the disc cover.

c
Caution:
❏ Do not yank Stacker 4 when pulling it out to remove published discs.

❏ Do not remove Stacker 4 when the Stacker 4 LED is flashing fast. Discs may be 
damaged.

❏ Unlock the lock lever when using Stacker 4.

❏ If you use Stacker 4 for output, do not install Stacker 3.
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Making the stacker settings

1. Make sure the product is turned on, and the product and computer are properly 
connected.

2. Click the Properties icon on the Publish screen of EPSON Total Disc Setup.
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3. Select External Output Mode for Publish Mode.
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4. Select the type of discs that you loaded into Stacker 1.
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5. Select the type of discs that you loaded into Stacker 2.

6. Click OK.

Making disc settings and creating labels

After loading discs into the stackers, access EPSON Total Disc Maker to make settings for 
writing discs, and create the labels printed on the discs.

Accessing EPSON Total Disc Maker

Click Start, point to All Programs (Windows XP) or Programs (Windows 2000), point to 
EPSON Total Disc Maker, and then click EPSON Total Disc Maker.

To learn how to use EPSON Total Disc Maker, go to the Help menu.
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Publishing discs

2007/05/29 10:29:21070511 unlocked and changedThe following instructions explain how to publish CDs/DVDs.

Note:
❏ If the disc is ejected or not fed correctly when you start a CD/DVD print job, make sure you 

loaded the stacker properly.

❏ If you select CD/DVD Premium Label as the Label Type setting in the Printer Settings window 
and use a high-quality CD/DVD, you can create high-quality CD/DVD labels.

❏ Be sure to let CDs and DVDs to dry completely before using them or touching the printed 
surface. Allow Epson specified discs to dry for at least 1 hour and other types of discs for at 
least 24 hours.

❏ If the print position is misaligned, adjust it using the printer driver. For details, refer to the printer 
driver Help.

❏ If the ink smears, adjust the color saturation. For details, refer to the printer driver Help.

Publishing Discs

1. Make the publish settings on the Publish screen of EPSON Total Disc Maker. For 
details, see Help for EPSON Total Disc Maker.

Note:
To access Help for EPSON Total Disc Maker, select Help from the Help menu.
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2. Click the Publish button.

c
Caution:
❏ Do not open the disc cover while the product is publishing discs, unless the application 

instructs to add or remove discs. This may affect write quality or print quality. Also, for 
safety reason, do not put your hands inside the product while beeping as arm is still 
moving.

❏ If you need to open the disc cover, pause or cancel your job before opening the disc 
cover.
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Batch Mode

New :Only for model with this feature

Loading CDs/DVDs

Follow the steps below to load CDs/DVDs.

1. Open the disc cover.

2. Take out Stacker 1.

3. Fan a stack of discs to prevent them from sticking together. Be careful not to scratch the 
recording side of the disc.
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4. Load CDs/DVDs into Stacker 1 with the printable side facing up.

c
Caution:
Do not load the discs above the red line marked on the stacker; otherwise, the discs or 
product may be damaged.

5. Insert Stacker 1.
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6. Take out Stacker 2.

7. Fan a stack of discs to prevent them from sticking together. Be careful not to scratch the 
recording side of the disc.

8. Load CDs/DVDs into Stacker 2 with the printable side facing up.

c
Caution:
Do not load the discs above the red line marked on the stacker; otherwise, the discs or 
product may be damaged.
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9. Insert Stacker 2.

10. Insert Stacker 3.

c
Caution:
❏ Make sure that there are no discs in Stacker 4 when using Stacker 3.

❏ When using Stacker 3, do not pull out Stacker 4. Be sure to lock the lock lever located 
on Stacker 4 when you use Stacker 3.
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11.Close the disc cover.

Making disc settings and creating labels

After loading discs into the stackers, access EPSON Total Disc Maker to make settings for 
writing discs, and create the labels printed on the discs.

Accessing EPSON Total Disc Maker

Click Start, point to All Programs (Windows XP) or Programs (Windows 2000), point to 
EPSON Total Disc Maker, and then click EPSON Total Disc Maker.

To learn how to use EPSON Total Disc Maker, go to the Help menu.

Publishing discs

2007/05/29 10:29:21070511 unlocked and changedThe following instructions explain how to publish CDs/DVDs.

Note:
❏ If the stacker is ejected or not fed correctly when you start a CD/DVD print job, make sure that 

you inserted the stacker properly.

❏ If you select CD/DVD Premium Label as the Label Type setting in the Printer Settings window 
and use a high-quality CD/DVD, you can create high-quality CD/DVD labels.

❏ Be sure to let CDs and DVDs to dry completely before using them or touching the printed 
surface. Allow Epson specified discs to dry for at least 1 hour and other types of discs for at 
least 24 hours.

❏ If the print position is misaligned, adjust it using the printer driver. For details, refer to the printer 
driver Help.

❏ If the ink smears, adjust the color saturation. For details, refer to the printer driver Help.
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Making the stacker settings

1. Make sure that the product is turned on, and the product and computer are properly 
connected.

2. Click the Properties icon on the Publish screen of EPSON Total Disc Maker or EPSON 
Total Disc Setup.
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3. Select Batch Mode for Publish Mode.
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4. Select the type of discs that you loaded into the stacker.

5. Click OK.
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Publishing Discs

1. Make the publish settings on the Publish screen of EPSON Total Disc Maker. For 
details, see Help for EPSON Total Disc Maker.

Note:
To access Help for EPSON Total Disc Maker, select Help from the Help menu.

2. Click the Publish button.

c
Caution:
❏ Do not open the covers while the product is publishing discs, unless the application 

instructs to add or remove discs. This may affect write quality or print quality. Also, for 
safety reason, do not put your hands inside the product while beeping as arm is still 
moving.

❏ If you need to open the covers, pause or cancel your job before opening the disc cover.
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Taking Out Discs

Follow the steps below to take out the published discs from the stackers.

1. Open the disc cover, and take out the stacker.

2. Take out the published discs from the stacker. The output stacker differs according to 
the publishing mode. Refer the following table.

3. Install the stacker in the product, and then close the disc cover.

Output stacker Mode Number of discs

Stacker 2 Standard mode 

Batch mode

Up to 50 discs

Stacker 3 Batch mode Up to 50 discs

Stacker 4 Standard mode

External Output mode

Up to 5 discs

Stacker 2 Stacker 3 Stacker 4
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Canceling Publishing

2007/04/23 10:15:54070402 unlocked and changedIf you need to cancel publishing, follow the instructions below.

When you start publishing, the screen of EPSON Total Disc Monitor appears on your 
computer screen. Select the job you want to cancel in the Unfinished Job list, and then 
select Cancel Job from the Job menu.
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Chapter 3 

Replacing Ink Cartridges

Checking the Ink Cartridge Status

Note:
❏ Epson cannot guarantee the quality or reliability of non-genuine ink. If non-genuine ink 

cartridges are installed, the ink cartridge status may not be displayed.

❏ When an ink cartridge is running low, the status is displayed on the EPSON Total Disc Monitor.

To check the ink cartridge status, do the following:

❏ EPSON Total Disc Monitor appears automatically when you start a job. You can check 
the ink cartridge status from this window.
You can also run EPSON Total Disc Monitor from the Start menu.
& See “Using EPSON Total Disc Monitor” on page 73.

Note:
If any of the ink cartridges installed in the product is broken, incompatible with the product 
model, or improperly installed, EPSON Total Disc Monitor will not display an accurate 
calculation of the ink cartridge status. Be sure to replace or reinstall any such ink cartridge with 
an ink cartridge supported by the product.
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Precautions on Ink Cartridge Replacement

2007/03/23 09:39:18070313 Unlocked and changedRead all the instructions in this section before replacing the ink cartridges.

❏ This product uses ink cartridges equipped with an IC chip that monitors the amount of 
ink used by each cartridge. Cartridges are usable even if they are removed and 
reinserted. However, some ink is consumed each time cartridges are inserted, because 
the product automatically checks their reliability.

❏ If you need to remove an ink cartridge temporarily, be sure to protect the ink supply 
area from dirt and dust. Store the ink cartridge in the same environment as the product. 
When storing the cartridge, do not place it with ink supply area facing down. Do not 
store ink cartridges upside down.

❏ The valve in the ink supply port is designed to contain any excess ink that may be 
released. However, careful handling is recommended. Do not touch the supply port of 
the ink cartridge or its surrounding area.

❏ Ink is consumed during the following operations: print head cleaning and ink charging 
when an ink cartridge is installed.

❏ For maximum ink efficiency, only remove an ink cartridge when you are ready to 
replace it. Ink cartridges with low ink status may not be used when reinserted.

❏ Do not refill the ink cartridges. Other products not manufactured by Epson may cause 
damage that is not covered by Epson's warranties, and under certain circumstances, 
may cause erratic product behavior.

❏ Keep ink cartridges out of the reach of children. Do not allow children to drink from or 
handle the cartridges.

❏ Be careful when you handle used ink cartridges, as there may be some ink around the 
ink supply port. If ink gets on your skin, wash the area thoroughly with soap and water. 
If ink gets into your eyes, flush them immediately with water. If discomfort or vision 
problems continue after a thorough flushing, see a doctor immediately.

❏ Epson recommends the use of genuine Epson ink cartridges. The use of non-genuine 
ink may cause damage that is not covered by Epson's warranties, and under certain 
circumstances, may cause erratic product behavior.

❏ Do not open the ink cartridge package until you are ready to install it in the product.

❏ Leave the old cartridge installed in the product until you have obtained a replacement; 
otherwise, ink remaining in the print head nozzles may dry out.

❏ You cannot continue printing with one ink cartridge expended, even if the other 
cartridges still contain ink. Before printing, replace the expended cartridge.
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❏ Do not turn off the product or open ink cartridge cover while loading ink (power light is 
flashing). Opening of covers may cause the ink to re-load, resulting in more of the ink 
being consumed.

Replacing an Ink Cartridge

Note:
Do not open the ink cartridge package until you are ready to install it in the product.

This table describes the status of the lights and the actions you need to take.

 : flashing

To replace an ink cartridge, follow the steps below.

c
Caution:
Do not remove the cartridge from the product until you are ready to replace it with another.

Note:
The illustrations show replacement of the light magenta ink cartridge, but the instructions are the 
same for all the cartridges.

1. Make sure that the  power light is on, but not flashing.

2. Open the ink cartridge cover.

Lights Action

Obtain a replacement ink cartridge.
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Note:
Wait for 4 seconds or more before removing the ink cartridge.

3. Push the expended cartridge so the cartridge is slightly pushed out. 
(If the ink in the cartridge is low, it is indicated by a flashing ink cartridge light.)

Note:
If an ink cartridge is low, you may continue to use it until it is expended. To confirm the status 
of each ink cartridge, see the following section:
& See “Using EPSON Total Disc Monitor” on page 73.

4. Carefully pull the expended cartridge straight out of the slot. Dispose of it properly.

5. Remove the new ink cartridge from the package.
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c
Caution:
❏ Do not touch the green IC chip on the side of the cartridge. This can damage the ink 

cartridge.

❏ Always install an ink cartridge immediately after removing the old cartridge. If the 
cartridge is not installed promptly, the print head may dry out and be unable to print.

❏ Do not refill the ink cartridge. Other products not manufactured by Epson may cause 
damage that is not covered by Epson's warranties, and under certain circumstances, 
may cause erratic product behavior.

6. Place the new ink cartridge into the slot. Then push the ink cartridge until it clicks into 
place.
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7. When you are finished replacing cartridges, close the ink cartridge cover.
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Chapter 4 

Maintaining Your Product

Checking the Print Head Nozzles

2007/02/22 17:07:16Unlocked and changed.If you find that the printout is unexpectedly faint or that dots are missing, you may be able 
to identify the problem by checking the print head nozzles.

You can check the print head nozzles from your computer by using the Nozzle Check 
utility.

Using the Nozzle Check utility

Follow the steps below to use the Nozzle Check utility.

1. Make sure that an unprinted disc with a 116 mm (4.57") or more outside diameter is 
installed in Stacker 1.

2. Make sure that no lights are indicating errors, and that the disc cover is closed.

3. Access the printer driver.

See “Accessing the printer driver” on page 14.

4. Click the Utility tab, then click the Nozzle Check button.

5. Follow the on-screen instructions.

Below are two sample nozzle check patterns.

Compare the quality of the printed check page with the sample shown below. If there 
are no print quality problems, such as gaps or missing segments in the test lines, the 
print head is fine.
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If any segment of the printed lines is missing, as shown below, this could mean a 
clogged ink nozzle or a misaligned print head.

& See “Cleaning the Print Head” on page 58
& See “Aligning the Print Head” on page 60

Cleaning the Print Head

New :Depends on model.In case of High-end IJ LFP, use <Hasei> parts.If you find that the printout is unexpectedly faint or that dots are missing, you may be able 
to solve these problems by cleaning the print head, which ensures that the nozzles are 
delivering ink properly.

You can clean the print head from your computer using the Head Cleaning utility in the 
printer driver or from the product by using the buttons.

Note:
❏ Clean the print head only if print quality declines; for example, if the printout is blurry or the color 

is incorrect or missing.

❏ Use the Nozzle Check utility first to confirm that the print head needs to be cleaned. This saves 
ink.

❏ When ink is low you may not be able to clean the print head. When ink is expended you cannot 
clean the print head. Replace the appropriate ink cartridge first.
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Using the Head Cleaning utility

Follow the steps below to clean the print head using the Head Cleaning utility.

1. Make sure the product is turned on.

2. Make sure that no lights are indicating errors, and that the disc cover is closed.

3. Access the printer driver.

See “Accessing the printer driver” on page 14.

4. Click the Utility tab, then click the Head Cleaning button.

5. Follow the on-screen instructions.

The  power light flashes while the product performs the cleaning cycle.

c
Caution:
Never turn off the product while the  power light is flashing. Doing so may damage the 
product.

Note:
❏ If print quality has not improved after repeating this procedure about four times, turn the product 

off and wait for at least six hours. Then run the nozzle check again and repeat the head cleaning 
if necessary.

❏ If the print quality still has not improved, at least one of your ink cartridges may be old or 
damaged and may need to be replaced.
& See “Replacing an Ink Cartridge” on page 53.

❏ If print quality remains a problem after replacing the ink cartridges, contact your dealer.

<Normal> <Clogged>
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Using the product buttons

Follow the steps below to clean the print head using the product buttons.

1. Make sure the product is turned on.

2. Make sure that no lights are indicating errors, and that the disc cover is closed.

3. Press and hold down the Cleaning button for three seconds.

The product starts cleaning the print head and the  power light begins flashing.

c
Caution:
Never turn off the product while the  power light is flashing. Doing so may damage 
the product.

4. When the  power light stops flashing, print a nozzle check pattern to confirm that 
the head is clean.
& See “Checking the Print Head Nozzles” on page 57.

Note:
❏ If print quality has not improved after repeating this procedure about four times, turn the product 

off and wait for at least six hours. Then run the nozzle check again and repeat the head cleaning 
if necessary.

❏ If the print quality still has not improved, at least one of your ink cartridges may be old or 
damaged and may need to be replaced.
& See “Replacing an Ink Cartridge” on page 53.

❏ If print quality remains a problem after replacing the ink cartridges, contact your dealer.

Aligning the Print Head

If you notice a misalignment of vertical lines or horizontal banding, you may be able to 
solve this problem by using the Print Head Alignment utility in your printer driver. 

Using the Print Head Alignment utility

Follow the steps below to align the print head using the Print Head Alignment utility.

1. Make sure that an unprinted disc with a 116 mm (4.57") or more outside diameter is 
inserted in Stacker 1.

2. Make sure that no lights are indicating errors, and that the disc cover is closed.
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3. Access the printer driver.

See “Accessing the printer driver” on page 14.

4. Click the Utility tab, then click the Print Head Alignment button.

5. Follow the on-screen instructions to align the print head.

Correcting the Printing Position

If you notice a misalignment of vertical printing position, you may be able to solve this 
problem by using the Correcting the Printing Position utility in your printer driver. 

Using the Correcting the Printing Position utility

Follow the steps below to adjust the vertical and horizontal printing position using the 
Correcting the Printing Position utility.

1. Make sure that a dummy disc or blank with a 116 mm (4.57") or more outside diameter 
is inserted in Stacker 1.

2. Make sure that no lights are indicating errors, and that the disc cover is closed.

3. Access the printer driver.

See “Accessing the printer driver” on page 14.

4. Click the Utility tab, then click the Correcting the Printing Position button.

5. Follow the on-screen instructions to adjust the vertical and horizontal printing position.

Cleaning Your Product

New :Inkjet Only.In case of SPC, use <Hasei> parts.

Cleaning the exterior of the product

To keep your product operating at its best, clean it thoroughly several times a year by using 
the following procedure.
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c
Caution:
❏ Never use alcohol or thinner to clean the product. These chemicals can damage the 

product.

❏ Take care to prevent water from getting inside the product. If moisture, dirt, or other 
matter gets inside of the product, besides affecting print quality, it may cause the electric 
circuits to short.

1. Make sure the product is turned off and all the lights are off, and then unplug the power 
cord from the electrical outlet.

2. Use a soft, clean cloth to carefully remove any dust or dirt.

If the dirt does not come off, clean it using a soft, clean cloth dampened with a mild 
detergent. Then, wipe the outside of the product dry with a dry, soft cloth.

Note:
❏ After cleaning the product, close the disc cover and the Stacker 4 tray to protect the product 

from dust.

❏ Make sure to clean the filter that is located on the rear of the product at regular intervals. See 
the next section.

Cleaning the interior of the product 

To keep your printouts at their best, clean the inside by using the following procedure.

1. Make sure the product is turned off and all the lights are off, and then unplug the power 
cord from the electrical outlet.

2. Open the disc cover, and remove the stackers from the product.

3. Use a soft, clean cloth to carefully remove any dust or dirt from the stackers and inside 
of the product.
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4. Place the stacker back in the position.

c
Caution:
❏ Be careful to keep water away from the electronic components.

❏ Do not spray the inside of the product with lubricants.

❏ Unsuitable oils can damage the mechanism. Contact your dealer or a qualified service 
person if lubrication is needed.

❏ Dirt attached to Stacker 3 or 4 should be wiped clean with a soft cloth moistened with 
neutral detergent.

Cleaning the filter 

Clean the filter located on the rear of the product once every six months. If you are using 
the product in a dusty area, clean it at shorter intervals. 

1. Make sure the product is turned off and all the lights are off, and then unplug the power 
cord from the electrical outlet.

2. Loosen and remove the screws from the filter covers to open them.

3. Remove the filters from the filter covers.

4. Use a vacuum-cleaner to clean the dust on the filters.

If the dust or dirt does not come off, clean the filters with water. Be sure to dry them 
completely before placing the filters back in position.
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5. Place the filters back in position.

6. Tighten the screws to close the filter covers.

Transporting Your Product

If you need to transport your product some distance, carefully prepare and repack it. Be 
sure to use the original box and packing materials.

w
Warning:
The product is heavy, so have two people lift the product.

c
Caution:
❏ When storing or transporting the product, do not tilt it, stand it up vertically, or turn it 

upside down. Otherwise, ink may leak from the cartridges.

❏ Leave the ink cartridges installed. Removing the cartridges can dry out the print head and 
may prevent the product from printing.

1. Turn off the product and unplug its power cord.

2. Disconnect the interface cable.

3. Remove all discs from the stackers.

4. Open the ink cartridge cover. Secure the ink cartridges with tape, then close the ink 
cartridge cover.

5. Close the disc cover and Stacker 4 tray. Secure them with tape.
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6. Attach the protective materials to both sides of the product.

7. Repack the product and accessories in the original box.

Note:
❏ Keep the product level during transport.

❏ Be sure to remove the protective materials and tape from the product before using it again.

❏ Be sure to lift the product by the correct positions, as shown below.
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Chapter 5 

Troubleshooting

Diagnosing the Problem

Troubleshooting product problems is best handled in two steps: first diagnose the problem, 
then apply likely solutions until the problem is fixed.

The information that you need to diagnose and solve most common problems is provided 
by Help, the control panel, and the EPSON Total Disc Monitor utility. Refer to the 
appropriate section below.

If you have a specific problem relating to publishing quality, a problem not related to 
publishing quality, or a disc feeding problem, or if the product does not publish at all, refer 
to the appropriate section.

To solve a problem, you may need to cancel publishing.
& See “Canceling Publishing” on page 50.

Error indicators

New :Depends on model (See Spec)You can identify many common problems using the lights on your product. If the product 
stops working and the lights are on or flashing, use the following table to diagnose the 
problem; then follow the recommended corrective measures.

Note
❏ Condition of indicator lights after error may change depending on the operation. 
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 : on,  : off,  : flashing,  : flashing fast

Error associated with cover

Error associated with disc transfer

Lights Conditions/Remedies

Power Busy Error Ink Stacker

1 2 3 4

Disc cover or ink cartridge cover open

Close covers.

Job is paused since disc cover or ink car-
tridge cover was opened while processing
the job

Wait for the job to resume.

Lights Conditions/Remedies

Power Busy Error Ink Stacker

1 2 3 4

Disc pick up error

Turn off the product and remove the disc
from the tray. If the same error occurs fre-
quently, contact your dealer.

Multiple feed error

Remove all discs from the drive and printer
tray to avoid causing any damage to the
product. Also, check that the discs are
loosely arranged in the stacker.
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Disc transfer error
Turn off the product and remove the disc. If
the same error occurs frequently, contact
your dealer.

Arm failed to release disc

Turn off the product and remove disc.

Do not remove disc from the arm by hand if 
arm is picking up the disc. This may damage 
the arm. If removing disc from the arm, turn 
on the product again and let initializing 
process remove the disc. To remove the disc 
from the arm, turn on the product again and 
let initializing process remove the disc.

If the same error occurs frequently, contact 
your dealer.

Internal error

Turn off the product and check inside for any
objects, then turn on the product again.
If the same error occurs frequently, contact
your dealer.
❏ Do not remove disc from the arm by 

hand if arm is picking up the disc. This 
may damage the arm. To remove the 
disc from the arm, turn on the product 
again and let initializing process remove 
the disc.

❏ If resuming label printing after the error, 
run Nozzle Check and confirm the 
condition of the print head.

❏ If the publishing does not start, check if a 
print job remains in the print spooler and 
delete all print jobs.

Lights Conditions/Remedies

Power Busy Error Ink Stacker

1 2 3 4
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Error associated with stacker

Lights Conditions/Remedies

Power Busy Error Ink Stacker

1 2 3 4

Stacker 3 is inserted for Standard Mode or 
External Output Mode

Remove Stacker 3.

Stacker 1 is not correctly inserted

Make sure that Stacker 1 is correctly inserted.

Stacker 2 is not correctly inserted

Make sure that Stacker 2 is correctly inserted.

Stacker 3 is not correctly inserted for Batch 
Mode

Make sure that Stacker 3 is correctly inserted.

Stacker 1 is empty

Load discs into Stacker 1.

Stacker 2 is empty

Load discs into Stacker 2.

Stacker 1 is overloaded

Remove discs so that discs are below the red 
line.

Stacker 2 is overloaded

Remove discs so that discs are below the red 
line.

Stacker 3 if full

Remove published discs from Stacker 3.

Stacker 4 if full

Remove published discs from Stacker 4.

Stacker 4 is open

Close Stacker 4.
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Error associated with ink

Lights Conditions/Remedies

Power Busy Error Ink Stacker

1 2 3 4

Ink low

Obtain a replacement ink cartridge. To 
determine which cartridge is nearly 
expended, check the ink cartridge status.
See “Checking the Ink Cartridge Status” on 
page 51.

Incorrectly installed ink cartridge

Reinsert the ink cartridge.
See “The ink light is flashing or is on after you 
replace the cartridge” on page 82.

Ink cartridge not fully inserted

All ink lights are on.
Check ink cartridges and make sure they are 
all fully inserted.
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Error associated with product

Lights Conditions/Remedies

Power Busy Error Ink Stacker

1 2 3 4

Ink pad full

Please have an authorized Epson service 
center service the ink pad right away.  The 
pad is full and the unit can no longer 
function.  Do not attempt to service the unit 
yourself.

Note:
If ink pad is nearly full, an "Ink Pad Nearly 
Full" message will be displayed by the 
software. There will be no lights indicating it.
Please have an authorized Epson service 
center service the ink pad right away.  The 
pad is nearly full and the unit will stop 
functioning when the pad becomes full.  Do 
not attempt to service the unit yourself.

Product maintenance error

A product maintenance error has occurred.

Turn off the product and contact your 
dealer.

Internal error

Turn off the product and check inside for any 
objects. If the same error occurs frequently, 
contact your dealer.

❏ Leaving the product off after the error 
may result in clogging of print head. 
Make sure to turn on the product 
immediately after turned off.

❏ If resuming label printing after the error, 
run Nozzle Check and confirm the 
condition of the print head.

❏ If the publishing does not start, check if a 
print job remains in the print spooler and 
delete all print jobs.
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Error associated with drive

Lights Conditions/Remedies

Power Busy Error Ink Stacker

1 2 3 4

Drive tray open/close error

Turn off the product and check inside for any 
objects. Also, unplug the power cable to 
clear the error. Then, publish the disc again. If 
the same error occurs frequently, contact 
your dealer.

Internal drive error

Turn off the product, unplug the power 
cable, and then check the inside of the 
drive. If the same error occurs frequently, 
contact your dealer.

Writing error

The error could not be cleared even if it 
repeated itself for the retry number of times. 

Disc may have a problem. Replace the disc 
and resume job.
If there is a problem with the drive, change 
the drive with EPSON Total Disc Setup and 
resume the job. If the same error occurs 
frequently, contact your dealer.

Invalid disc error

An invalid disc error has occurred, such as 
the disc may not be blank or the disc does 
not have enough space. Or, the disc loaded 
in the stacker differs from the disc type you 
set in the EPSON Total Disc Setup Properties 
dialog box.

The error could not be cleared even if it 
repeated itself for the retry number of times.

Check that the disc is blank and not 
damaged.
Then, in the EPSON Total Disc Setup Properties 
dialog box, select the disc type that is the 
same as the discs loaded in the stacker. If 
you use the proper disc but the same error 
occurs frequently, contact your dealer.
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Other error

EPSON Total Disc Monitor

If a problem occurs while printing, an error message will appear in the EPSON Total Disc 
Monitor window.

If an error message appears indicating the parts inside the product are near the end of their 
service life or the waste ink pad in the product is saturated. Contact your dealer to replace 
it.

Checking Product Status

Using EPSON Total Disc Monitor

New :Depends on modelEPSON Total Disc Monitor displays detailed information on the product status.

There are three ways to access EPSON Total Disc Monitor:

❏ When you send a job to the product, EPSON Total Disc Monitor appears.

❏ In the EPSON Total Disc Maker window, click the Publish button. From the Tool menu, 
select Start Total Disc Monitor.

❏ For Windows XP and 2000:
Click Start, point to All Programs (Windows XP) or Programs (Windows 2000), point 
to EPSON Total Disc Maker, and then click EPSON Total Disc Monitor.

Lights Conditions/Remedies

Power Busy Error Ink Stacker

1 2 3 4

Improper status error
Turn the product off and on. If the same error 
occurs frequently, contact your dealer.
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When you access EPSON Total Disc Monitor, the following window appears:

EPSON Total Disc Monitor provides the following information:

❏ Job list:
You can check a list of jobs (up to 1000 for Unfinished Job and 50 for Finished Job) and 
its information, and also you can cancel, pause, and restart unfinished jobs.

❏ Device Status:
This provides device status information. It also displays error messages as well as 
helpful tips for better publishing. 

❏ Ink Cartridge Status:
This provides a graphic display of the ink cartridge status.

❏ Drive, Printer, Stacker Status:
This provides a graphic display of the drives, printer, and stacker status. It also shows 
where an error occurs.

Print Quality Problems

If you are having a print quality problem, then compare it with the illustrations below. Click 
the caption under the illustration that best resembles your printout.
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Horizontal banding

❏ Make sure the printable side of the disc is face up in the Stacker.

❏ Run the Head Cleaning utility to clear any clogged ink nozzles.
& See “Cleaning the Print Head” on page 58.

❏ Use ink cartridges within six months after opening the packages.

Good sample Good sample

“Horizontal banding” on page 75 “Vertical misalignment” on page 
76

“Horizontal banding” on page 75 “Vertical misalignment” on page 
76

“Incorrect or missing colors” on 
page 76

“Blurry or smeared printout” on 
page 77
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❏ Use genuine Epson ink cartridges.

❏ Check the H ink light. If the light is flashing, replace the appropriate ink cartridge.
& See “Replacing an Ink Cartridge” on page 53.

❏ Make sure the label type selected in the printer driver is appropriate for the type of disc 
loaded in the product.
& See “Publishing Discs” on page 17.

Vertical misalignment

❏ Run the Print Head Alignment utility.
& See “Aligning the Print Head” on page 60.

❏ Make sure the label type selected in the printer driver is appropriate for the type of disc 
loaded in the product.
& See “Publishing Discs” on page 17.

Banding

❏ Make sure the printable side of the disc is face up in the Stacker.

❏ Run the Head Cleaning utility to clear any clogged ink nozzles.
& See “Cleaning the Print Head” on page 58.

❏ Make sure the label type selected in the printer driver is appropriate for the type of disc 
loaded in the product.
& See “Publishing Discs” on page 17.

❏ Due to the variation in the quality of discs, print results using the same type of discs 
from the same data may not be the same.

Incorrect or missing colors

❏ Adjust the color settings in your application or in your printer driver settings.
Check the Main window. 
See the printer driver online Help for details.

❏ Run the Head Cleaning utility.
& See “Cleaning the Print Head” on page 58.

❏ Check the H ink light. If the light is flashing, replace the appropriate ink cartridge.
& See “Replacing an Ink Cartridge” on page 53.
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❏ If you have just replaced an ink cartridge, make sure the date on the box has not 
expired. If you have not used the product for a long time, replace the ink cartridges.
& See “Replacing an Ink Cartridge” on page 53.

Blurry or smeared printout

❏ Use genuine Epson ink cartridges.

❏ Make sure the product is on a flat, stable surface that extends beyond the base in all 
directions. The product will not operate properly if it is tilted.

❏ Make sure your disc is not damaged, dirty, or too old.

❏ Make sure your disc is dry and the printable side is facing up.

❏ Make sure the label type selected in the printer driver is appropriate for the type of disc 
loaded in the product.
& See “Publishing Discs” on page 17.

❏ Do not touch or allow anything to come into contact with the printed side of disc with a 
shiny finish. After printing on a glossy disc, allow the ink to set for a few hours before 
handling it.

❏ Run the Head Cleaning utility.
& See “Cleaning the Print Head” on page 58.

Miscellaneous Printout Problems

Incorrect or garbled characters

2007/03/23 09:39:18070313 Unlocked and changed

❏ Clear any stalled print jobs from the Windows Spooler (Windows XP and 2000).

❏ Turn off the product and computer. Make sure the product’s interface cable is securely 
plugged in.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling EPSON Total Disc Maker” on page 15.
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Incorrect margins

❏ Check the Inner/Outer Diameter settings in your application. Make sure that the 
margins are within the printable area of the disc.
& See “Printable area” on page 92.

❏ Make sure the printer driver settings are appropriate for the label size you are using.
Check the Main window.
See the printer driver online Help for details.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling EPSON Total Disc Maker” on page 15.

❏ The printing location may shift depending on the disc used. Perform Print Head 
Alignment or Correcting the Printing Position.
& See “Correcting the Printing Position” on page 61.

❏ The ink receptor layer may shift from the center of the disc making the print location to 
appear shifted from the ink receptor layer. Check if the ink receptor layer is shifted from 
the center of the disc or from the outer edge.

Printout has a slight slant

❏ Perform Nozzle Check, Print Head Cleaning, and Print Head Alignment utilities.

Printed side is smeared or scuffed

❏ Select the appropriate disc size setting in the printer driver.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling EPSON Total Disc Maker” on page 15.

Printing is too slow

❏ Make sure the label type selected in the printer driver is appropriate for the type of disc 
loaded in the product.
& See “Publishing Discs” on page 17.

❏ Close any unnecessary applications.

❏ Make sure that printing mode is set to bi-directional.
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❏ If you print continuously for an extended period, the disc may temporarily stop feeding 
or the printing may pause for a while. This is to slow down the printing speed and 
prevent the product mechanism from overheating and being damaged. If this happens, 
you can continue to print, but we recommend stopping and leaving the product for about 
thirty minutes with the power on. (The product does not recover with the power off.) 
After you restart, the product will print at normal speed.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling EPSON Total Disc Maker” on page 15.

Ink adheres to the recording surface

❏ Depending on the type of disc, ink may adhere to the recording surfaces if they are 
stacked right after printing. Make sure of the type of disc before using.

Disc or the CD/DVD Tray Does Not Feed Correctly

Disc does not feed

Remove the stack of discs and make sure of the following:

❏ The disc is not damaged.

❏ The disc is not too old. See the instructions that came with the disc for more 
information.

❏ The stack of discs fits under the red line on the stacker.

❏ Discs may have stuck together because of incorrect transportation of the discs; 
therefore, discs should be separated thoroughly before loading into the stacker. Also, 
storing discs in the stacker for an extended period of time may cause discs to stick to 
each other again. If discs are stored in the stacker for an extended period of time, 
separate the discs again before operating the product.

❏ A disc is not jammed inside the product. If it is, remove the jammed disc.
& See “Disc jams” on page 80.

❏ The ink cartridges are not expended. If a cartridge is expended, replace it.
& See “Replacing an Ink Cartridge” on page 53.
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Multiple discs feed

❏ Make sure the disc stack fits under the red line on the stacker.

❏ Make sure none of the discs are damaged.

❏ Remove the stack of discs and make sure that the discs are not too thin.
& See “Discs” on page 90.

❏ Remove discss from the stacker and fan them before loading them back.

❏ If only one disc is found when multiple feed error is displayed, disc thickness or 
warpage maybe out of standard. If the same error continues to occur, replace discs.

Disc jams

New :Depends on model (See spec)If a disc is left in the drive or printer tray, it will be ejected when you turn off/on the product. 
If you cannot remove the disc by restarting the product, follow the procedures below:

❏ If a disc is stuck in the printer tray, turn off the product, unplug the power cable from the 
wall outlet, and open the disc cover located on the rear of the product. Then remove all 
the discs inside. Close the disc cover. After removing the discs, clean the printer tray.

❏ If a disc is stuck in the drive tray, turn off the product, unplug the power cable from the 
wall outlet, and then insert a pin into the eject hole to open the tray forcibly. Then, 
remove the disc from the tray and close it.

Note:
Insert a pin into the hole and push to eject the tray when the tray doesn’t unload by pressing the 
Eject button. In normal operation, the eject button should be used to unload the tray. Make sure 
the power of the product is turned off and wait more than one minute until disc rotation is 
stopped before accessing with the eject hole.

Note:
❏ If you cannot easily remove a foreign object, do not use force and do not disassemble the 

product. Call your dealer for assistance.

❏ If arm is stopped while picking up disc, do not try removing disc by hand. This may result in 
damaging the arm. If such an error occurs, turn off/on the power and try resolving the problem 
by initializing the product. If the error continues to occur, contact customer support.

If your discs jam frequently, make sure of the following:

❏ The discs are smooth, not damaged.

❏ You are using a high-quality discs.
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❏ The printable side of the discs are face up in the stacker.

❏ The stack of discs was fanned before loading.

❏ The stack of discs is not loaded above the red line on the stacker.

❏ The number of discs in the stacker does not exceed the limit specified for that disc.
& See “Mechanical” on page 94.

❏ The product is on a flat, stable surface that extends beyond the base in all directions. 
The product will not operate properly if it is tilted.

Writing Problem

Cannot write to the disc

Avoid using the product where dust or smoke is abundant. It may result in write error. 
If a disc write error occurs frequently, check the following:

❏ The disc is not damaged.

❏ The disc is high-quality.

❏ The product is used within acceptable environmental conditions.

❏ The product is not subject to vibration or shock.

❏ The fan filter is not clogged with dust.

❏ The printer tray is not dirty.

The Product Does Not Functiont

All lights are off

❏ Press the P power button to make sure the product is on.

❏ Turn off the product, and make sure that the power cord is securely plugged in.

❏ Make sure that your outlet works and is not controlled by a wall switch or timer.
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Lights came on and then went out

The product’s voltage may not match the outlet rating. Turn off the product and unplug it 
immediately. Then check the label on the back of the product.

c
Caution:
If the voltage does not match, DO NOT PLUG YOUR PRODUCT BACK IN. Contact your 
dealer.

Only the power light is on

❏ If you press the P power button lightly, the product may not turn on, although the  
power light flashes for a while. Press the button firmly.

❏ Turn off the product and computer. Make sure the product’s interface cable is securely 
plugged in.

❏ If you are trying to print a large image, your computer may not have enough memory. 
Try reducing the resolution of your image or printing the image at a smaller size. You 
may need to install more memory in your computer.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling EPSON Total Disc Maker” on page 15.

The ink light is flashing or is on after you replace the cartridge

Make sure the ink cartridge is correctly installed.

Software cannot be installed

❏ Is the USB cable unplugged? Make sure that the USB cable is firmly connected.

❏ Does the USB cable match the computer and the product requirements? The USB 
cable used to connect the computer and the product should be High-Speed USB.

❏ Has the HDD sufficient free space? The software cannot be installed if the HDD does 
not have free space of more than 10GB.

❏ Did you log on as a user with administrator privileges (belonging to the administrator 
group) for Windows? When installing the software, log on as a user with administrator 
privileges (belonging to the administrator group).
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❏ Are you using a USB hub? The USB cable should be connected directly between the 
PC and the product.

When installing the software, make sure to turn the product off; then start installation. 

Ink Pad Nearly Full message is displayed by the software

Ink pad is nearly full. Please have an authorized Epson service center replace the ink pad 
right away.  The pad is nearly full, and the unit will stop functioning when the pad becomes 
full.  Do not attempt to service the unit yourself.
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Appendix A 

Where To Get Help

New :See comments to select sections you need. The word "other" indicates products except for inkjet, SPC, Page, and SIDM.

Contacting Customer Support

New :For All products

Before Contacting Epson

If your Epson product is not operating properly and you cannot solve the problem using the 
troubleshooting information in your product documentation, contact customer support 
services for assistance. If customer support for your area is not listed below, contact the 
dealer where you purchased your product.

Customer support will be able to help you much more quickly if you give them the following 
information:

❏ Product serial number
(The serial number label is usually on the back of the product.)

❏ Product model

❏ Product software version
(Click About, Version Info, or similar button in the product software.)

❏ Brand and model of your computer

❏ Your computer operating system name and version

❏ Names and versions of the software applications you normally use with your product

Help for Users in the United States and Canada

Contacts for information, support, and services are:

Discproducer Technical Support: 562-276-1360

Location: Epson America Inc.

Web site URL: http://www.discproducer.epson.com
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This site will provide the end user with access to the latest drivers and FAQs.

Help for Users in the Europe (EMEA)

Contacts for information, support, and services are:

Web site URL: http://www.discproducer.epson-europe.com

If you need the latest drivers, FAQs, manuals, or other downloadable, access the site at:

http://download.epson-discproducer.com

Or contact your local distributor or Epson sales company.
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Appendix B 

Product Information

Product Parts and Control Panel Functions

New :Depends on model

Product Parts

a.  Ink cartridge cover: Secures the ink cartridges. Open only when installing or replacing ink 
cartridges.

b.  Control Panel: Use the button and monitor the lights to control your product. See the next 
section for details.

c.  Disc cover: Open when loading or taking out the discs.

d.  Power button: Turns the product on or off.

a b

cd
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c
Caution:
Before opening the disc remover cover, be sure to unplug the power cable from the wall 
outlet. Be sure to attach this cover while in use.

e.  AC inlet: Plug in the power cord.

f.  USB connector: Connects a USB cable from your computer to the product. 

g.  Interface cable locking saddle: Use this for directing and gathering the cable.

h.  Air Vent: Leave at least 10 cm (3.94") between the back of the product and the wall for 
ventilation.

i.  Disc remover cover: Open this cover only when a disc is stuck in the printer tray.

j. Drive 1: Writes data on the recording surface of discs.

e f g h

i

r

mop n

j k l

q

Product Information 87



Control Panel

Buttons

Lights

k. Arm: Transports discs.

l.  Stacker 1: Use Stacker 1 as a disc input stacker. Holds up to 50 discs.

m.  Stacker 2: Use Stacker 2 as a disc input or output stacker. Holds up to 50 discs.

n.  Lock lever: Use this lever to lock or unlock Stacker 4. Lock the lever when you use Stacker 3 
in Batch mode.

o.  Stacker 3: Use Stacker 3 as a disc output stacker. Holds up to 50 discs.

p.  Stacker 4: Use Stacker 4 as a disc output stacker. Holds up to 5 discs.

q. Printer: Prints on label surface of discs.

r. Drive 2: Writes data on the recording surface of discs.

Button Function

cleaning

Press and hold for 3 seconds to clean the print head.

Light Description

power

On when the product is on.

Flashes when the product is initializing, after replacing an ink cartridge, 
charging ink, or cleaning the print head.

Flashes when jobs are processed.
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For details on error status, see the following instructions.
& See page 66.

Ink and Disc

Ink cartridges

New :Depends on model (See Spec)You can use the following ink cartridges with this product:

To purchase a PP-100 Series exclusive ink cartridge, check with the dealer where you 
purchased your PP-100 or access either of the following urls:

http://www.discproducer.epson-europe.com (Europe)
http://www.discproducer.epson.com (United States and Canada)

On when errors occur, such as when the disc cover or ink cartridge cover 
is open, the arm fails to pick up a disc, multiple discs are loaded into the 
drive, after a disc error or a writing error.

Flashes when disc errors occur.

INK

On when an ink cartridge is expended or is not correctly inserted.

Flashes when an ink cartridge is nearly expended.

STACKER

On when the stacker is overloaded with discs, or when Stacker 3 is not 
removed for the Standard and External Output mode. 

Flashes when the stacker is not installed correctly or the stacker is out of 
discs.

When the Stacker 4 light flashes rapidly, do not pull out Stacker 4.

Ink cartridge Part numbers

Cyan C13S020447

Light Cyan C13S020448

Light Magenta C13S020449

Magenta C13S020450

Yellow C13S020451

Black C13S020452
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Discs

New :Dependson model (See Spec)Epson offers the specified CD-R and DVD-R discs for all your printing needs.

System Requirements

For using the product

New :Depends on model (See Spec)

Windows requirements

To use this product, you must have any of the following Windows operating systems 
installed.

Note:
❏ If your file system is FAT, you may not write to a DVD.

❏ ATI South Bridge chip set IPX460 or earlier is incompatible with this product.

❏ Refer to the URLs listed on pages 84 and 85 for chip sets that are not supported.

❏ The product may not function properly if third party writing software is installed, anti-virus 
software is installed, and another USB device is connected.

❏ The source drive should be MMC4 or higher and capable of reading sub-channels.

Operating system Windows XP Service Pack 2 or higher
Windows 2000 Service Pack 4 or higher

CPU Pentium 4 1.4 GHz or higher processor

Memory 512 MB RAM or more 

Hard disk space 10 GB or more free hard disk space

HDD rotational speed 7200 rpm or more

Interface Hi-Speed USB

Display XGA or higher resolution, 65536 colors or more

Other Making music CD: Require sound device with appropriate driver 
installed.
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Technical Specifications

Disc

New :Depends on model (See Spec)

Note:
❏ Since the quality of any particular brand or type of disc may be changed by the manufacturer at 

any time, Epson cannot attest to the quality of any brand or type of disc. Always test samples 
of disc stock before purchasing large quantities or printing large jobs.

❏ Poor quality disc may reduce print quality and cause disc jams or other problems. If you 
encounter problems, switch to a higher grade of disc.

❏ The specified disc is for ink jet printers. Thermal transfer discs are not supported.

❏ The specified disc has a moisture adhesive ink receptor layer on the label surface. If stored 
stacked, especially under high humidity and high temperature conditions, discs may adhere to 
each other. If an automatic duplication machine is used, please check the disc before using.

❏ Please treat the recording surface (blue green colored side) and printing surface carefully so 
they do not have fingerprints, dirt, dust, water, or scratches. Dust and dirt on the recording 
surface should be wiped gently with soft dry cloth, commercially available CD cleaner, or ethyl 
alcohol. Do not use benzine, thinner, or antistatic material.

CD/DVD:

Notes for handling the disc

❏ The specified discs hava a moisture-adhesive ink receptor layer on the label surface. If 
stored stacked, especially under high humidity and high temperature conditions, disc 
may adhere to each other. If an automatic duplication machine is used, please check 
the disc before using.

❏ Let the discs dry naturally after printing. Touching the surface with your hand or 
splashing the surface with water right after printing may result in blurriness and 
stickiness.

Type CD-R, DVD-R, DVD+R, DVD-R DL, DVD+R DL

Outer diameter 120 mm ± 0.3 mm (4.724 ± 0.012")

Inner diameter 15 mm + 0.1/- 0 mm (0.591 +0.004"/-0")

Thickness 1.2 mm + 0.3/- 0.1 mm (0.047 +0.012"/-0.004")

Label side Printable
*Glossy labels other than the specified disc are not 
supported.

Specified disc CD-R, DVD-R
Product Information 91



❏ Avoid storing under high temperatures and high humidity, which may result in blurriness 
and stickiness of the printing surface.

❏ When storing, keep the disc in its disc case and avoid letting film or cards touch the 
printing surface. These may scratch the printing surface.

❏ Do not use with an auto loading mechanism, a drive with a holding mechanism larger 
than 33 mm, or an automotive drive. Depending on the condition used, the printing 
surfaces may stick.

❏ Printing after writing to the disc is recommended.

❏ Do not attach an adhesive sticker to the disc. This may result in the disc being unable 
to record or play.

❏ The recording surface side has a concentric ring projection called the stack ring. 
Depending on the disc, projection of the stack ring is small and use of such disc may 
cause the disc to stick before printing. It is recommended to check the disc before use. 

Printable area

Printable area is the area for the label printing.
The printable area can be set from Set Inner/Outer Diameter screen of the EPSON Total 
Disc Maker.
In the Set Inner/Outer Diameter screen, you can select Standard, Wide, or set manually.
Following diagram shows the printable area for Standard and Wide. Printing will be done in 
the gray area.

New :Depends on modelCD/DVD:

12-cm (4.72") CD/DVD (Standard) 12-cm (4.72") CD/DVD (Wide)

Inner diameter Outer diameter Inner diameter Outer diameter

45 mm (1.77") 116 mm (4.57") 25.5 mm (1.00") 116 mm (4.57")

45 mm

116 mm

25.5 mm

116 mm
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c
Caution:
❏ Make sure to set the inner diameter and the outer diameter within the areas shown above. 

Printing on sections outside the printable area may damage your CD/DVD drive.

❏ The EPSON Total Disc Maker can set between inner diameter of 18 mm to outer diameter 
of 119.4 mm (0.71 to 4.70"). However, printing outside printable area (45 to 116 mm) may 
result in sticking. It is recommended to check the disc type before using.
When printing outside printable area (ink absorbing layer) of the disc is being used, ink 
printed outside the printable area does not fix. Check the label of the printable area of the 
disc being used before setting.

❏ Precautions for setting the printable area
-Make sure that the printable area set does not exceed the printable area of the actual 
disc being used.
-Check whether coloration of print made on the rib (stack ring) is not uniform.
-Printing on the rib (stack ring) may cause ink sticking, disc sticking, and ink erasure after 
printing.

❏ Measures to be taken when printing outside printable area
When printing inside the inner diameter results in ink sticking, disc sticking, and ink 
erasure, the following action can be taken to avoid that.
-Set Drying Time on the printer driver’s printer settings screen and print. Although 
throughput may be reduced, problems will be avoided or reduced since the disc will be 
ejected after a set time.
-Enable Publish after Mask Rib Area. If you print from another application, set from the 
user-defined label setting in the printer driver. If you print from the Total Disc Maker, set 
from Set Inner/Outer Diameter setting.

Note:
When you print on CDs/DVDs with a commercially available software package that supports 
CD/DVD printing, you have to make the following settings.

Ink cartridges

Size 124 x 124 mm (4.88 x 4.88")

Type CD/DVD Label, CD/DVD Premium Label, or EPSON 
Specified CD/DVD Label

Margins on all sides 2 mm (0.08")

Color Black, Yellow, Magenta, Light Magenta, Cyan, Light Cyan

Cartridge life Use within 6 months of opening the package.

Temperature Storage:
-20 to 40 °C (-4 to 104 °F) 

1 month at 40 °C (104 °F)
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c
Caution:
❏ Epson recommends the use of genuine Epson ink cartridges. Other products not 

manufactured by Epson may cause damage that is not covered by Epson’s warranties, 
and under certain circumstances, may cause erratic behavior.

❏ Use the ink cartridge before the expiration date printed on its package.

❏ Do not refill the ink cartridge. Other products not manufactured by Epson may cause 
damage that is not covered by Epson's warranties, and under certain circumstances, may 
cause erratic behavior.

Note:
❏ The ink cartridges packaged with your product are partly used during initial setup. In order to 

produce high-quality printouts, the print head in your product will be fully charged with ink. This 
one-off process consumes a quantity of ink, and therefore these cartridges print fewer pages 
compared to subsequent ink cartridges.

❏ Do not store ink cartridges under high or freezing temperatures, or under direct sunlight.

❏ To ensure that you receive premium print quality and to help protect your print head, a variable 
ink safety reserve remains in the cartridge when your product indicates to replace the cartridge. 
The yields quoted for you do not include this reserve.

❏ Cartridge yields vary considerably based on images printed, print settings, disc type, frequency 
of use and temperature. For print quality, a variable amount of ink remains in the cartridge after 
the "replace cartridge" indicator comes on. This product ships with full cartridges and part of the 
ink from the first cartridges is used for priming its printer. See www.discproducer.epson.com for 
more information about cartridges.

Mechanical

New :Depends on model (See Spec)

Electrical

New :Depends on model (See Spec)

Drive Two drives, tray loading type

Stacker capacity Stacker 1 to 3: Max. 50 discs

Stacker 4: Max. 5 discs

Dimensions Width: 377 mm (14.8 inches)

Depth: 465 mm (18.3 inches)

Height: 348 mm (13.7 inches)

Weight Approx. 24 kg (53 lb) with accessories

Input voltage range AC 100 to 240 V

Rated frequency range 50 to 60 Hz

Rated current 1.0 A
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Note:
Check the label on the back of the product for its voltage.

Environmental

New :Depends on model (See Spec)

*1 Without condensation

Standards and approvals

New :Depends on model (See Spec)

Interface

New :Depends on model (See Spec)

Power 
consumption

Printing 41 W

Standby mode 24 W

Temperature Operation:
10 to 35 °C (50 to 95 °F)

Storage: 
-20 to 40 °C (-4 to 104 °F)

1 month at 40 °C (104 °F)

Humidity Operation:*1 
20 to 80% RH

Storage:*1

5 to 85% RH

Safety UL60950-1
CAN/CSA-C22.2 No.60950-1

EMC FCC Part 15 Subpart B Class B 
CAN/CSA-CEI/IEC CISPR 22 Class B

Low voltage directive 2006/95/EC EN60950-1

EMC directive 2004/108/EC EN55022 Class B 
EN61000-3-2 
EN61000-3-3
EN55024

Hi-Speed USB (Device Class for computers)

Hi-Speed USB (for PictBridge or USB DIRECT-PRINT compliant devices)
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Lifetime

Epson estimates lifetime for components of this product to be as follows: 

Expected Lifetime: 

Ink pad life: About 30,000 discs printed
Burner life: About 16,000 to 40,000 discs burned

The product's ink pad is expected to become saturated and need replacing after printing 
about 30,000 discs.  The burner life estimate is the combined life for the two burners, with 
the low estimate based on burning DVDs only, and the high estimate based on burning 
CDs only.  Expected lifetimes are only estimates.  Actual results will vary based on such 
factors as images printed, print settings, disc type, frequency of use, temperature, and mix 
of CDs vs. DVDs burned. 
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correcting, 61
Printing

canceling, 50
Print quality, improving, 74
Print speed, increasing, 78
Problems

banding, 75, 76
blurry prints, 77
diagnosing, 66
incorrect characters, 77
incorrect colors, 76
margins, 78
paper feeding, 79
paper jams, 80
printer does not print, 81
print speed, 78
smeared prints, 77, 78

Product
buttons, 88
checking status, 73
cleaning, 61
transporting, 64

R

Replacing ink cartridges, 53

S

Safety information, 7
Service, 84
Smeared prints, 77, 78
Software

uninstalling, 15
Specifications

ink cartridges, 89
mechanical, 94
paper, 91

Speed, increasing, 78
Stacker, 88
Status Monitor

Windows, 73
System requirements, 90

T

Transporting product, 64
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Windows
accessing printer settings, 14
status monitor, 73
Index 98


	Copyright and Trademarks
	Contents
	Important Notice and Safety Instructions
	Important Note
	Important Safety Instructions
	Setting up the product
	Choosing a place for the product
	Using the product
	Handling ink cartridges
	Notice for CD/DVD discs
	Concerning incidental loss arising out of this product
	About usage limitation
	Warnings, Cautions, and Notes


	Using Your Software
	Adding the product
	Overview of EPSON Total Disc Maker
	EPSON Total Disc Maker
	EPSON Total Disc Monitor
	EPSON Total Disc Setup

	Using EPSON Total Disc Maker
	Starting EPSON Total Disc Maker

	Overview of Printer Driver
	Accessing the printer driver

	Uninstalling EPSON Total Disc Maker

	Publishing Discs
	Introduction
	Turning power on/off
	Overview of publishing mode
	Drive settings
	Printer settings
	Notice for CD/DVD writing and printing
	Printing on CDs/DVDs with a commercially available software package

	Standard Mode
	Loading CDs/DVDs
	Making disc settings and creating labels
	Publishing discs

	External Output Mode
	Loading CDs/DVDs
	Making disc settings and creating labels
	Publishing discs

	Batch Mode
	Loading CDs/DVDs
	Making disc settings and creating labels
	Publishing discs

	Taking Out Discs
	Canceling Publishing

	Replacing Ink Cartridges
	Checking the Ink Cartridge Status
	Precautions on Ink Cartridge Replacement
	Replacing an Ink Cartridge

	Maintaining Your Product
	Checking the Print Head Nozzles
	Using the Nozzle Check utility

	Cleaning the Print Head
	Using the Head Cleaning utility
	Using the product buttons

	Aligning the Print Head
	Using the Print Head Alignment utility

	Correcting the Printing Position
	Using the Correcting the Printing Position utility

	Cleaning Your Product
	Cleaning the exterior of the product
	Cleaning the interior of the product
	Cleaning the filter

	Transporting Your Product

	Troubleshooting
	Diagnosing the Problem
	Error indicators
	EPSON Total Disc Monitor

	Checking Product Status
	Using EPSON Total Disc Monitor

	Print Quality Problems
	Horizontal banding
	Vertical misalignment
	Banding
	Incorrect or missing colors
	Blurry or smeared printout

	Miscellaneous Printout Problems
	Incorrect or garbled characters
	Incorrect margins
	Printout has a slight slant
	Printed side is smeared or scuffed
	Printing is too slow
	Ink adheres to the recording surface

	Disc or the CD/DVD Tray Does Not Feed Correctly
	Disc does not feed
	Multiple discs feed
	Disc jams

	Writing Problem
	Cannot write to the disc

	The Product Does Not Functiont
	All lights are off
	Lights came on and then went out
	Only the power light is on
	The ink light is flashing or is on after you replace the cartridge
	Software cannot be installed
	Ink Pad Nearly Full message is displayed by the software


	Where To Get Help
	Contacting Customer Support
	Before Contacting Epson
	Help for Users in the United States and Canada
	Help for Users in the Europe (EMEA)


	Product Information
	Product Parts and Control Panel Functions
	Product Parts
	Control Panel

	Ink and Disc
	Ink cartridges
	Discs

	System Requirements
	For using the product

	Technical Specifications
	Disc
	Ink cartridges
	Mechanical
	Electrical
	Environmental
	Standards and approvals
	Interface
	Lifetime


	Index

